
Tips for getting started with FarmVille Tracker

Each "record" in FarmVille Tracker consists of the date, the total
coins you had on that date, the number of coins you earned on
that date, the total number of XPs, the number of XPs earned on
that day, and the number of FVs, Fuel, Neighbors, etc. as of that
date.

It is highly recommended that you create a new record for
each each day. Just click the New Day button at the top of the
screen. You can use the arrow buttons at the bottom right corner
of the screen to easily go to other days. You can jump to any date
by clicking the date field at the top of the window and entering a
date.

Your first task will be to decide what date you want to start with. You can add previous dates to
the system at a later time, but you should only use these for totals, if you have them recorded
elsewhere. Buildings, Collections, Decorations, Vehicles, and Milestones (levels, awards,
expansions, etc.) do not require a "record" and can be added for any date at any time. If you have
not been keeping track prior to using the software, just start with the current date.

Animals, crops, trees, and gifts are all recorded on a daily basis. However these are handled
slightly differently. With animals and trees you enter your inventory only once and then on a
daily basis record how many of these were harvested or collected from. You record which
crops you planted each day, how many were planted and how many were harvested. When
you create a new day, all crops that were completely harvested drop off the list. All others are
kept on the list until they are harvested. Gifts give and received are kept track of on a daily basis.
Neighbors helped and Notes are also only tracked on a daily basis.

New Day

Click the New Day button at the top left of the screen at the beginning of each day in order to
create a record for that day. In the File menu you will find menu items for Delete Day (if you want
to start over for a single day) and Delete All (if you want to start complete

Simple Mode

If you only want to keep track of totals for each day, enable the Simple mode option at the top of
the FarmVille Tracker window.

Save

Click the Save button at the top left of the screen to save your data. Data is automatically saved
when you go to another day or choose the Quit menu item.

Help

Click the Help button at the top left of the screen to view the online help system. The help topic
for the selected tab will be displayed. You can Print or Export one or all help topics if you wish.
Use the list of topics on the left of the screen to read about that topic. If you don't find a topic
listed, enter one or more words in the Search for: field at the top of the window and then click the
Search button. The following is the information in the Help window for your online reference.

 

About FarmVille Tracker

Welcome to FarmVille Tracker

This handy application keeps track of all your neighbors, gifts, awards, animals, trees, crops,
buildings, vehicles and decorations. It records overall totals, along with daily totals, and can
generate reports.

FarmVille Tracker is very comprehensive but you do not need to use any more of it than
you wish. There are no required fields. Some people may only want to keep track of their totals at
the end of the day. If this includes you, enable the Simple Mode option at the top of the window.

Because of the changing nature of the FarmVille game, this software may not account for some of
the latest changes and additions to the game. Therefore it is a good idea to adjust your totals (at
the top of the window) at the end of each day.

The software is divided into windows that represent daily tasks and inventories, and more static
lists, such as Neighbors, Assets (Buildings, Collections, Decorations and Vehicles) and
Milestones (Awards and Ribbons, Expansions, and Levels). You can sort any of these lists by
clicking the column headings. Clicking the heading again sorts the list in the reverse order.

The main window has a row of tabs that show the following groups of information: Animals,
Crops, Gifts, Purchases, Trees, Neighbors Helped, and Notes/Prefs (Preferences).

In this software XPs are experience points and FVs are FarmVille dollars that you earn or buy.
Coins are what you spend and collect from harvesting.

http://productivity-software.com/index.html
http://productivity-software.com/index.html
http://productivity-software.com/farmville/testimonials.html
http://productivity-software.com/farmville/download.html
http://productivity-software.com/farmville/register.html
http://productivity-software.com/farmville/support.html
http://productivity-software.com/farmville/faqs.html
http://productivity-software.com/about.html
http://mac.softpedia.com/progClean/Activity-Expense-Tracker-Plus-Clean-2937.html


When you open the program for the first time, the current date is entered into the Date field. If you
want to start recording activities on a prior date, click the Date field and fill in the first date you
want to use.

We suggest you start with the current date and add all your existing animals, trees, crops, etc. but
if you want to start with some previous date, you can.

To add a new day into the database, start by clicking the New Day button in the main window.

When you have more that one day entered, arrows will appear in the lower right corner of the
main window which will take you to the record for the First, Next, Previous or Last day entered.

You may want to take inventory on a piece of paper of all your animals, trees, decorations, etc.
before starting with the software, but you can also have both the game and this application
running at the same time and switch between them.

Click the Animals tab and then click Add/Select Animal. Choose an animal and enter the total
number of this type of animal you have. Repeat this process for each animal. As you harvest (or
collect from) these animals, you will click each line and note how many were Harvested (or
collected from). The Daily Profit for each animal (and the total profit) will be calculated.

Click the Crops tab and then click Add/Select Crop. Choose a crop and enter the total number
of this type of crop you have planted. Repeat this process for each crop. As you harvest the
crops, you will click each line and note how many were Harvested. The Profit for each crop (and
the total profit) will be calculated.

Click the Trees tab and then click Add/Select Tree. Choose a tree and enter the total number of
this type of tree you have. Repeat this process for each tree. As you harvest (or collect from)
these trees, you will click each line and note how many were Harvested. The Daily Profit for
each tree (and the total profit) will be calculated.

You can also keep track of Gifts you give and receive each day. Gifts received are added to the
lists of Animals, Trees, and Decorations.

When you purchase an Animal, Vehicle, Decoration, etc. click the Purchases tab and then click
the appropriate button. Your purchase will be added to the appropriate list and the totals will be
calculated. It is possible to spend more coins or XPs than you have (in the software) and cause
these totals to be negative values.

Keep track of what Neighbors you helped each day by clicking the Neighbors Helped tab.

Click the Notes/Prefs tab to find a Notes field for any misc. notes and Preference settings for
Date and Time formats.

The total coins, xps, etc. are approximate (ie, may not match the totals in the game) and should
be updated manually at the end of each day for accuracy.

At the bottom of the screen you will find buttons to take you to the Reports window (there are two
choices - a graph and a text report), the Neighbors window, the Assets window (which includes
Buildings, Decorations and Vehicles) and the Milestones windows (where you can keep track of
Awards and Ribbons, Expansions, and Levels).

To backup the data, choose Export from the File menu and save the .txt file to your computer.
You can also make a copy of the FVDB.rev file. You should copy either of these files to another
disk for safe keeping.

Click each topic in the menu to the left of this field to find out more about each screen.

Animals

Keep track of all your Animals by clicking the Animals tab. The Animals inventory list will be
revealed.

When you are setting up the software you will need to add all your animals to the list by clicking
Add/Select Animal for each Animal you have in inventory. When you click Choose Animal you
will be asked for the number of this animal you currently have on your farm.

Each day you can specify how many of each animal you harvested (or collected from). To do this,
click the line in the Animals inventory list and enter the number harvested in the resulting dialog.
You can also change the total number or indicate how many were sold in this dialog.

The Daily Profit for each Animal will be equal to the number Sold times the sales Price plus the
number Harvested times the number of Coins per harvested animal. Daily totals are automatically
generated.

When you buy an Animal, click Purchases and then Add an Animal. Animals that are gifted to
you are automatically added to the list.

You can edit the Total # in Inventory, the Number Bought, the Number Sold, and the Number
Harvested by clicking a line in the Animals inventory list. You can also delete the line by clicking
Remove Animal.

In the Choose an Animal window, (which appears when you click the Add/Select Animal button)
if you need to change an aspect of an existing Animal, just click the line and then click Modify
Animal. A dialog will ask which aspect you want to change.

If you do not see an animal in the list, click Update List in the Choose an Animal window. If the
animal is not automatically added then click the Add a New Animal to this List button.

Assets

Assets include Buildings, Collections, Decorations and Vehicles.



Click one of these topics on the left for more information.

Awards and Ribbons

Keep track of all your Awards and Ribbons by clicking the Milestones button at the bottom of
the main window and then the Awards and Ribbons tab.

Click Add Award or Ribbon and specify the name or description of the award, ribbon or crop
mastery, and then the date and (if you have the current date selected in the main window) any
XPS or Coins collected.

The Total # of Awards or Ribbons, and the total XPs and Coins are shown at the bottom of the
window.

To edit a line in the list, click the item in the line you want to edit and a dialog will ask for the new
information.

To delete a line in the list, click the line with the ctrl (or Apple) key held down.

Clicking the Print button creates a text report of just the Awards and Ribbons which you can then
Print or Save as... a text file.

Buildings

Keep track of all your Buildings by clicking the Assets button at the bottom of the main window
and then the Buildings tab. The Buildings inventory list will be revealed.

When you are setting up the software you will need to add all your Buildings to the list by clicking
Add/Select Building for each building you have in inventory.

When you buy a Building, click Purchases and then Add a Building. Buildings that are gifted to
you are automatically added to the list.

You can edit the Date Purchased, the Date Sold, and the Sale Price for each Building by
clicking a line in the inventory list. You can also delete the line by clicking Remove Building.

In the Choose a Building window (which appears when you click the Add/Select Building
button), if you need to change an aspect of an existing Building, just click the line and then Modify
Building. A dialog will ask which aspect you want to change.

If you do not see a Building in the list, click Update List in the Choose a Building window. If the
Building is not automatically added then click the Add a New Building to this List button.

Clicking the Print button creates a text report which you can then Print or Save as... a text file.

Collections

Keep track of all your Collections by clicking the Assets button at the bottom of the main window
and then the Collections tab. The Collectons inventory list will be revealed.

When you are setting up the software you will need to add all your Collections to the list by
clicking Add/Select Collection for each Collection Item you have in inventory. When you click
Choose Collection you will be asked for the number of this item you have in inventory.

You can edit the # Collected, the Group name, and the Scarcity (Common, Rare, etc.) by
clicking a line in the Collections inventory list. You can also delete the line by clicking Remove
Collection.

In the Choose a Collection window (which appears when you click the Add/Select Collection
button), if you need to change an aspect of an existing Collection, just click the line and then the
Modify Collection button. A dialog will ask which aspect you want to change. You can edit the
Collection item's Name, the Group, the Scarcity (Common, Rare, etc.), and the Sale Price.

If you do not see a Collection in the list, click Update List in the Choose a Collection window. If
the Collection is not automatically added then click the Add a New Collection to this List button.

Clicking the Print button creates a text report which you can then Print or Save as... a text file.

Crops

Keep track of all your Crops by clicking the Crops tab. The Crops inventory list will be revealed.

When you are setting up the software you will need to add all your Crops to the list by clicking
Add/Select Crop for each Crop you have in inventory. When you click Choose Crop you will be
asked for the number of fields currently planted with that crop.

Each day you can specify how many of each Crop you plant and harvest. To do this, click the line
in the Crops inventory list and enter the number planted and harvested in the resulting dialog.

The daily Profit for each Crop will be equal to the number of crops Harvested times the number
of coins per harvested crop (Sold ea.).

Daily totals are automatically generated and include: the total number of Plowed fields (including
any planted but not harvested from a previous day), the total number of Planted fields, the total
XPs earned for plowing and planting, the total number of Harvested fields, the total number of
coins earned for harvesting fields (Sold), the total number of coins spent for planting fields (Cost
of seed), and the Profit (total Sold - Cost for planting).

Also in included in the daily crop totals are: the total number of Fallow fields, the total number of
fields that were plowed but not planted (PNP), the total number of fields that were plowed and
then deleted (DPF), the number of Total Fields, the total Plowed Cost (15x the total Plowed +
PNP + DPF), the Total Cost (Plowed Cost + Cost of seeds), and the Net Profit (total Sold - Total



Cost).

You can edit the Number Planted, the Time Planted and Number Harvested by clicking a line in
the inventory list. Crop time is approximate and for your reference only. It is not used in any
calculations and is optional. You can also delete the line by clicking Remove Crop.

In the Choose a Crop window (which appears when you click the Add/Select Crop button) , if
you need to change an aspect of an existing Crop, just click the line and then click Modify Crop.
A dialog will ask which aspect you want to change.

If you do not see a Crop in the list, click Update List in the Choose a Crop window. If the Crop
is not automatically added then click the Add a New Crop to this List button.

Decorations

Keep track of all your Decorations by clicking the Assets button at the bottom of the main
window and then the Decorations tab. The Decorations inventory list will be revealed.

When you are setting up the software you will need to add all your Decorations to the list by
clicking Add/Select Decoration for each Decoration you have in inventory. When you click
Choose Decoration you will be asked for the number of this item you have in inventory.

When you buy a Decoration, click Purchases and then Add a Decoration. Decorations that are
gifted to you are automatically added to the list.

You can edit the Total # in Inventory, the Number Purchased, the Number Sold, and the
amount Each Sold For by clicking a line in the Decorations inventory list. You can also delete the
line by clicking Remove Decoration.

In the Choose a Decoration window (which appears when you click the Add/Select Decoration
button), if you need to change an aspect of an existing Decoration, just click the line and then the
Modify Decoration button. A dialog will ask which aspect you want to change.

If you do not see a Decoration in the list, click Update List in the Choose a Decoration window.
If the Decoration is not automatically added then click the Add a New Decoration to this List
button.

Clicking the Print button creates a text report which you can then Print or Save as... a text file.

Expansions

Keep track of all your Expansions by clicking the Milestones button at the bottom of the main
window and then the Expansions tab.

To add a previous expansion to the list, click Add Expansions and specify the type or size, and
then the Date of the expansion.

To add a current expansion, click Purchases in the main window and then Add an Expansion.
You will be asked for the type or size, the date and the amount paid in FVs or Coins. Totals will
be adjusted if the Automatically Update Totals option is enabled in the Preferences section.

The Total # of Expansions, ad the total XPs and Coins are shown at the bottom of the window.

To edit a line in the list, click the item in the line you want to edit and a dialog will ask for the new
information.

To delete a line in the list, click the line with the ctrl (or Apple) key held down.

Clicking the Print button creates a text report which you can then Print or Save as... a text file.

Gifts

Keep track of what gifts you give and receive from your Neighbors each day by clicking the Gifts
tab. Two lists will appear, one for Gifts Received and one for Gifts Given.

When you click Add/Select Gift Received a list of Neighbors and Gifts will appear. Choose a
Neighbor and then the Gift they gave you. If the gift came from the game, enable the Received
from Game option.

The next step is to click the line in the Gifts Received From list and choose Kept, Sold or
Ignored. If you click Ignore on the Gift Requests Page (in Facebook) then choose Ignore. If you
sell the gift rather than adding it to your farm then choose Sold. Gifts that are Kept are added to
the appropriate inventory list.

When you click Select Gifts Given a list of Neighbors and Gifts will appear. Choose a Gift and
then all the Neighbors you gave that gift to. The Neighbors and Gifts(s) will automatically be
added to the Gifts Given To list. The # of Gifts Given for that neighbor will be updated in the
Neighbors list.

If you do not see a Gift in the list, click Update List in the Choose a Neighbor and a Gift
window (which appears when you click either the Add/Select Gift Received or Select Gifts
Given button). If the Gift is not automatically added then click the Add a New Gift to this List
button.

If you do not see a Neighbor in the list, click the Add Neighbor button at the bottom left of the
window.

To use the Paste Gift List feature:

1) Go to your Gift Requests Page (in Facebook)

2) Copy all the FarmVille Names, gifts, pictures, etc. to the clipboard (ctrl + c or Apple + c)

 



3) Switch back to FarmVille Tracker

4) Click the Paste Gift List button

The new names and gifts will be added to the Gifts Received From list and the # of Gifts
Received, Last Gift Received and the Date of Last Gift Received for each of these neighbors
will be updated in the Neighbors list.

Levels

Keep track of all your Levels by clicking the Milestones button at the bottom of the main window
and then the Levels tab.

Click Add Levels and specify the Level, the date and any Notes. If you have the current date
selected in the main window, the Level field there will be updated.

To edit a line in the list, click the item in the line you want to edit and a dialog will ask for the new
information.

To delete a line in the list, click the line with the ctrl (or Apple) key held down.

Clicking the Print button creates a text report of just the Levels which you can then Print or Save
as... a text file.

Menus and Shortcuts

There are five menus at the top of the window (or screen) that allow access to both common and
less common functions of the software.

In the File menu you will find: New Day and its keyboard shortcut ctrl + N (or Apple + N on the
Mac); Find Date and its keyboard shortcut ctrl + F (or Apple + F on the Mac); Delete Date (to
delete just the current date - or record) and Delete All (use this only if you want to start
completely over); Close Window and its keyboard shortcut ctrl + W (or Apple + W on the Mac);
Save Data and its keyboard shortcut ctrl + S (or Apple + S on the Mac); Import Data and Export
Data (use these to backup and restore all the data contained in the software).

About, Preferences and Quit -- and its keyboard shortcut ctrl + Q (or Apple + Q on the Mac) --
are located in different menus depending on if you are using the Mac or Windows version of the
software.

In the Edit menu you will find: Cut and its keyboard shortcut ctrl + X (or Apple + X on the Mac);
Copy and its keyboard shortcut ctrl + C (or Apple + C on the Mac); Paste and its keyboard
shortcut ctrl + V (or Apple + V on the Mac); Clear (similar to cut) and Select All and its keyboard
shortcut ctrl + A (or Apple + A on the Mac). Undo is not supported but sometimes works when
typing.

In the Inventory menu you will find: Add Gifts (which shows the Gifts section in the main
window) and its keyboard shortcut ctrl + G (or Apple + G on the Mac); Add Purchases and its
keyboard shortcut ctrl + P (or Apple + P on the Mac) shows the Purchases section.

You can also go directly to the Add an Animal, Add a Building, Add a Crop, Add a Collection
Item, Add a Decoration, Add a Tree and Add a Vehicle windows. These all take you to the
associated window where you can pick an item to add to your inventory. This is NOT the same as
Add Purchases.

In the Window menu you will find: FarmVille Tracker and its keyboard shortcut ctrl + T (or Apple
+ T on the Mac) which will take you to the main window (if you are in some other window);
Milestones and its three submenus (Awards and Ribbons, Expansions and Levels); and
Assets and its four submenus (Buildings, Collections, Decorations, and Vehicles) which will
take you to these windows (if you are in some other window); Neighbors and Farmville Report
and its keyboard shortcut ctrl + R (or Apple + R on the Mac). You will be asked if you want to
view a Graph Report or a Text Report when you choose this last item.

In the Help menu you can go to the Help Index or the Licensing (or Registration) window.

Milestones

Milestones include Awards and Ribbons, Expansions and Levels. You can keep track of the
Dates and the amount of Coins or XPs collected for achieving the Milestone.

Click one of these topics on the left for more information.

Neighbors

Click the Neighbors button at the bottom of the main window to open the Neighbors window.

Click Add Neighbor to add one or more Neighbors. If you choose One, you will be asked only for
a Name and Level. If you choose Import from HTML you need to begin by opening your
Neighbors page (from Facebook) and saving the source of the page (choose Save or Save as
from the File menu in your browser - and choose HTML ONLY) to your computer as an html file.
Then when you click Import from HTML you will be asked to locate that file. The list will be
replaced with your current neighbors and their Levels, photos, etc.

When you click a line in the Neighbors list, all of the information about that neighbor will be
displayed if available. You can add any of this data at any time by clicking a line and then clicking
a field on the right.

To edit the neighbor's Name or Level, select the line and click Modify Neighbor. To delete a
neighbor, select the line and click Remove Neighbor.

Neighbors data includes their XPs, Coins, the # of Gifts Given from you to them, the # of Gifts



Received by you from them, the # of Neighbors they have, the # of Achievements they have,
the Last Gift you Received from them and the Date the Last Gift was Received.

Some of these fields are automatically filled in when you give or receive a gift from the Neighbor in
the Gifts section.

If you think a Neighbor has quit playing the game, you can disable the Still Playing? option.

If you Import from HTML a Show Picture option will appear. If this is enabled the Neighbor's
Picture will be downloaded from the Internet. Click Show Larger Profile Picture to show the
Neighbor's profile picture from FaceBook.

Neighbors Helped

Keep track of what Neighbors you helped each day by clicking the Neighbors Helped tab.

When you click Choose Neighbor a list of neighbors will appear. Click a line and then click
Choose Neighbor. A dialog will appear where you can specify the number of XPs and Coins you
gained by Helping with chores, Fertilizing fields, Feeding the Chickens, or any Other Coins
earned.

At the bottom of the Neighbors Helped section are totals for the number of neighbors Helped,
the Help XPs, the Help Coins (including Chicken Feeding and Other Coins), the Fertilize XPs
and the Fertilize Coins.

You can click on a line in the Heighbors Helped list and edit the Help XPs, the Help Coins
(which includes Chicken Feeding and Other Coins), the Fertilize XPs and the Fertilize Coins.

Notes/Prefs (Preferences)

Click the Notes/Prefs tab to access the Notes field and various Preferences. Use the Notes field
for any misc. notes of any length.

When the Automatically Update Totals option is enabled, the totals at the top of the main
window are updated automatically when you buy, harvest or sell items.

If the Automatically Update Totals option is not enabled, then you must update totals at the end
of the day manually. When you change the XPs or Coins the XPs Today or Profit Today fields
are updated with the difference between the total for the current day and the previous day.

We recommend leaving the Automatically Update Totals option off and manually entering totals
at the end of each day. The Daily totals will be calculated for you. This software does not account
for every expense and credit that the game does.

When you click on some buttons there are visual effects that enhance the change in the screen. If
you don't like these effects then turn off the Visual Effects option.

You can change the Preference settings for Date and Time formats if you wish.

The Cost per plowed field will probably never change, but just in case it does, there is a field
you can edit.

You can change the colors in all the windows by clicking Set Background Color.

You can create a backdrop for the application, to hide the desktop and other programs by clicking
Set Desktop Cover and the clicking one of the colored squares. The one on the lower left can be
changed to any color or any of a large number of patterns supplied with the software.

At the top of the main window you will find a Simple Mode option. Enabling this hides the
Animals, Crops, Gifts, Purchases, Trees, Neighbors and Notes sections and makes the window
much shorter. Disabling this option reveals all the features of the program again.

Purchases

Click the Purchases tab to enter all your purchases for the current date.

Choosing Add an Animal adds the animal to the Purchases list and the Animals inventory.
Choosing Add a Building adds a building to the Purchases list and the Buildings inventory.
Choosing Add a Decoration adds one or more decorations to the Purchases list and the
Decoration inventory. Choosing Add a Tree adds the tree to the Purchases list and the Tree
inventory. Choosing Add a Vehicle adds the vehicle to the Purchases list and the Vehicle
inventory. Choosing Add an Expansion adds the expansion to the Purchases list and the list of
Expansions.

Coins or FVs spent on the Purchase will be deducted from the Totals at the top of the window.
XPs collected for the Purchase will be added to the XP totals.

You can delete or edit a line in the Purchases list by clicking the line.

Reports

When you click the Reports button at the bottom of the main window you will have a choice of
viewing the Text Report or the Graph Report.

In the Graph Report, you can display data for the following date ranges: 3 to 12 Days OR 3 to 12
Weeks OR 3 to 12 Months. Some of these choices may not be available until you have entered
sufficient data. The last day is always the current date, the Days, Weeks or Months is prior to
today.

If there is not enough data to support any of these choices you can use the Demonstration option
to create some fake data for you to experiment with.



If you choose Days, there will be a data point for each day. if you choose Weeks there will be a
data point for the average of that week. If you choose Months there will be a data point for the
average of that month.

If there is no data for the first date selected, 0 will be reported. If there is no data for any other
date, an average will be computed. The numbers on the vertical axis range from the lowest to the
highest values within the data set.

Below the graph are 12 choices of data to display in the graph. These are: Total Coins, Daily
Coins, Total XPs, Daily XPs, Profit from Trees, Profit from Crops, Total Fields Planted, Profit
from Animals, Gifts Received, FVs, Fuel Levels and Neighbors. Many of these choices will not
be available if you have Simple Mode enabled on the FarmVille Tracker screen.

The scale to the left of the graph is recalculated each time so that the top number is equal the
maximum value. You can hover over each data point to see the exact #.

Click the colored square next to each option to change the color of the graph lines and data points
for that option.

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

The Text Report shows any or all data, for all days, for any period of time, and can be printed or
saved as a text file. There are many options available so you can choose which data to include in
the report.

At the top of the text report window are options for each type of data contained in the databases.
Use the menu button at the top right to select All or None of these options. Many of these options
will not be available if you have Simple Mode enabled on the FarmVille Tracker screen.

When you have Simple Mode enabled on the FarmVille Tracker screen the Totals Only option
will be selected for you. You can choose to include Buildings, Decorations, Vehicles,
Neighbors, Awards and Ribbons, Expansions, and Levels when Totals Only is selected.

You can not include information about Animals, Crops, Gifts, Purchases, Trees, Neighbors
Helped, or Notes when Totals Only is selected.

Click the Date Options button to reveal a date range menu and fields for the Start Date and End
Date. Click a field to set a date. Hide these fields by clicking Other Options.

After making changes to the options, click Create Report.

At the bottom of the window are buttons for saving the report as a text file, changing the Font of
the report and printing the report.

Click the Font button to change the size of the text in the report. Smaller sizes may print better.

Trees

Keep track of all your Trees by clicking the Trees tab. The Trees inventory list will be revealed.

When you are setting up the software you will need to add all your Trees to the list by clicking
Add/Select Tree for each Tree you have in inventory. When you click Choose Tree you will be
asked for the number of this tree you have in inventory.

Each day you can specify how many of each Tree you harvested. To do this, click the line in the
Trees inventory list and enter the number harvested in the resulting dialog. You can also change
the total number or indicate how many were sold in this dialog.

The Daily Profit for each Tree will be equal to the number Sold times the sales Price plus the
number Harvested times the number of Coins per harvested tree. Daily totals are automatically
generated.

When you buy a Tree, click Purchases and then Add a Tree. Trees that are gifted to you are
automatically added to the list.

You can edit the Total # in Inventory, the Number Bought, the Number Sold, and the Number
Harvested by clicking a line in the Trees inventory list. You can also delete the line by clicking
Remove Tree.

In the Choose a Tree window (which appears when you click the Add/Select Tree button), if you
need to change an aspect of an existing Tree, just click the line and then click Modify Tree. A
dialog will ask which aspect you want to change.

If you do not see a Tree in the list, click Update List in the Choose a Tree window. If the Tree is
not automatically added then click the Add a New Tree to this List button.

Vehicles

Keep track of all your Vehicles by clicking the Assets button at the bottom of the main window
and then the Vehicles tab. The Vehicles inventory list will be revealed.

When you are setting up the software you will need to add all your Vehicles to the list by clicking
Add/Select Vehicle for each Vehicle you have in inventory.

When you buy a Vehicle, click Purchases and then Add a Vehicle. Vehicles that are gifted to you
are automatically added to the list.

You can edit the Date Purchased, the Date Sold, and the Sale Price for each Vehicle by clicking
a line in the inventory list. You can also delete the line by clicking Remove Vehicle.

In the Choose a Vehicle window (which appears when you click the Add/Select Vehicle button),
if you need to change an aspect of an existing Vehicle, just click the line and then the Modify



Vehicle button. A dialog will ask which aspect you want to change.

If you do not see a Vehicle in the list, click Update List in the Choose a Vehicle window. If the
Vehicle is not automatically added then click the Add a New Vehicle to this List button.

Clicking the Print button creates a text report which you can then Print or Save as... a text file.
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